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Overview of Collaborative Networks

NOTE:
Configuration of a collaborative network must be handled by Ex Libris.

Alma supports data sharing and collaboration across institutions in a 
streamlined manner. Each institution may choose its collaborative partners and 
establish a collaborative network to jointly manage shared resources. 

 OCLC Publishing on page 47

 Configuring Inventory Available For Management Groups for 
Collaborative Environments on page 48

 Defining Display Logic Rules at the Campus Level on page 52

 Shared Vendor Information on page 55

 Centralized Management of Configuration Tables on page 58

 Centralized Management of Notification Letters on page 64

 Relinking a Portfolio to a Different Bibliographic Record in the 
Network Zone on page 67

 Sharing Import Profile Templates in the Network Zone on page 68

 Monitoring Collaborative Network Jobs Across Institutions on 
page 70

 Switching Between Institutions on page 71

 Centralized Cataloging in the Network Zone on page 73

 Creating Records in the Network Zone with the Portfolio Loader on 
page 83

 Linking Local Inventory to Bibliographic Records in the Network 
Zone or the Community Zone on page 84

 Relinking Holdings to the Network Zone or the Community Zone 
on page 89

 Cataloging Privileges in the Network Zone on page 92
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Figure 1: Collaborative Network

Distributing Users Across a Network Zone
You can distribute a user in a Network Zone to all member institutions in the 
collaborative network. When doing so, the user becomes a registered user at all 
member institutions in the network. The userʹs account type remains the same 
after it is distributed (that is, external accounts remain external, and internal 
accounts remain internal).

When distributing a user to a Network Zoneʹs member institutions, the new 
user inherits all roles from the user in the Network Zone, except for the 
following:

 Roles assigned to a specific library (such as Circulation Desk Operator)

 Roles assigned specific parameters on the User Roles Details page (see 
Adding Roles to Users in the Alma Administration Guide).

To distribute a user from the Network Zone to the member institutions:

On the Find and Manage Users page (Administration > User 
Management > Find and Manage Users), select Actions > Distribute for a user 
and click Confirm in the confirmation dialog box. The Find and Manage Users 
page reappears, and the user is distributed to the member institutions in the 
network.
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Sharing User IDs within a Fulfillment Network in a Network 
Zone

In a fulfillment network, if users have not already been distributed to each 
member institution (see Distributing Users Across a Network Zone on page 5), 
when a patron from institution A walks into institution B, the patron’s 
information is retrieved from institution A as the first step of managing the 
patron’s activities. The records at each institution contain a hidden field that 
indicates their relationship, but all identifier fields (such as student ID, barcode, 
etc) remain non‐unique between institutions. The identifiers are not copied from 
the other institution.

Alternately, in a fulfillment network that contains members of a network zone, 
Ex Libris can configure that user identifiers that are identical for that patron 
throughout all linked institutions. For example, the fulfillment network can be 
configured such that a specified user name configured at one fulfillment 
network institution is automatically configured in the linked record at the other 
institutions.

NOTE:
If you use the same IDs to identify students at multiple institutions, ensure 
that these IDs are unique at all member institutions.

To activate or to modify these settings after they have been configured, contact 
Ex Libris Support.

Working with the Repository Search and MD 
Editor in a Collaborative Network

The Network Zone enables bibliographic data to be shared between 
collaborating institutions for cataloging and inventory purposes. 

As part of the Network Zone environment, the Network tab is added to the 
Repository Search facility. Using this tab, collaborating institutions can search 
for resources within their shared network. 

With the Is linked advanced search option for an All Titles search from the 
Institution tab, Alma provides a method for locating records that are linked (or 
not) to the Network Zone and the Community Zone. When performing the 
same search from the Network tab, all bibliographic records that are linked to 
the Community Zone will be displayed. The Is linked index (for All Titles 
searches) is defined the same for the Institution tab and the Network tab.

You can configure the default results tab for certain types of searches. For more 
information, see Customizing the Repository Search in the Alma Resource 
Management Guide.
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The following is an example of search results. For an explanation of the icons 
and other indicators used, see Icons and Indicators Displayed in the Network 
and Institution Tabs below.

Figure 2: Network Tab Search Results

NOTE:
The Network tab is available for collaborative network member 
institutions only. For the institution serving as the Network Zone, this tab 
is not available. 

The following functions may be performed in relation to shared bibliographic 
data:

 Editing the shared bibliographic record – In the Network tab, click Edit 
beneath the record. The record opens in edit mode.

 Merging duplicate bibliographic records into one in the Network Zone – 
Bibliographic records can be merged when editing them from the results in 
the Network tab (using the MD Editor). For more information on merging 
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records, see Merging Bibliographic Records in the Resource Management 
Guide.

In a Network Zone environment, the records that you select to merge cannot 
include local member records. The records that you merge must be Network 
Zone bibliographic records.

Before merging the records, a note is provided with a list of all the other 
member institutions that also have inventory for the secondary record, 
which will be moved to the primary record. When you are logged in to the 
Network Zone system, the list of what you are about to move reflects the 
number of bibliographic record changes specific to the Network Zone 
inventory. When you are logged in to a member institution system, the list of 
what you are about to move reflects the number of bibliographic record 
changes specific to the local, member institution’s inventory.

For the current institution that is performing the merge operation, the 
changes to the primary bibliographic record will be immediately available. 
For other member institutions that hold the primary bibliographic record, 
there may be a slight delay (up to five minutes) while the system handles the 
processing changes in the background.

 Linking to the shared bibliographic record – In the Network tab, click the 
record title link. On the MARC Record Simple View Page, click Link at the 
bottom of the page. A message indicating that the item was linked to the 
local institution is displayed at the top of the page. For an explanation of the 
icons that appear in the Network and Institution tabs, refer to Icons and 
Indicators Displayed in the Network and Institution Tabs on page 10.

 Copying the shared bibliographic record to the local repository – In the 
Network tab, click Edit beneath the record and select File >  Copy to 
institution in the MD Editor. The record then appears in the Institution tab 
as well. After the record is copied locally, the system detaches any records at 
the member institutions that link to the same Community Zone record and 
links them to the enriched record at the Network Zone institution. The Held 
By field for the record at the Network Zone institution displays the member 
institutions that have inventory for this record.

NOTE:
The localized records will no longer receive updates from the Community 
Zone, and any member institutions that have activated this resource will 
benefit from the updates made to the local record at the Network Zone 
institution.

 Associating inventory with the shared bibliographic record – In the 
Network tab, click Edit beneath the record. Click the Add Holdings or Add 
Items button on the toolbar, or select Tools > MARC21 Bibliographic > Add 
Local Portfolio (refer to MD Editor Menu and Toolbar Options in the Alma 
Resource Management Guide). The inventory you create is automatically 
linked to the shared bibliographic record. For an explanation of the icons 
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that appear in the Network and Institution tabs, see Icons and Indicators 
Displayed in the Network and Institution Tabs below.

 Contributing a locally created record to the shared bibliographic record – In 
the Institution tab, click Edit beneath the record and select File > Share with 
network in the MD Editor. Refer to the procedure To configure the MD 
Editor Share With Network function to find matches based upon the 035 
field: below for information regarding how to configure the MD Editor 
Share with Network function.

 Validating changes to a record – Before contributing a record to the Network 
Zone, you can choose to validate changes to the record based on the 
collaborative network cataloging standards by selecting Tools > Validate in 
Collaborative Zone in the MD Editor. You can also choose whether you 
want to save changes to a revised record locally or in the network 
(File > Options in the MD Editor).

 Configuring error messages for 9XX fields added to Network Zone records – 
For information on configuring an error message to be displayed when 
adding 9XX fields to Network Zone records, see Configuring an Error 
Message to Be Displayed When Manually Adding 9XX Fields to Network 
Zone Records on page 16.

 Identifying brief records – Once your system has been configured for 
identifying brief records (refer to Identifying Brief Records on page 287 in 
the Alma Administration Guide), the MD Editor provides a Brief indicator for 
the records that have been identified as brief (refer to Brief on page 217 in 
the Alma Resource Management Guide for an explanation of this indicator).

In a collaborative network, both the Network Zone system and the member 
institution system may each be configured (by Ex Libris) with an algorithm 
to identify brief records. The brief record algorithm configured for the 
Network Zone (that is, the network institution) affects only the Network 
Zone records, and local records are defined as brief according to the brief 
record algorithm configured for the local member institution.

In general, it is suggested that member institutions of a collaborative 
network should use the same brief record algorithm for all members and for 
the network. 

 View network members’ order details ‐ When you open the Held by Details 
page by clicking a member’s Held by link in the search results, the Orders 
tab on the Held by Details page shows the order information for that 
member.
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To configure the MD Editor Share With Network function to find matches 
based upon the 035 field:

1 Open the Mapping Table page for Other Settings (Resource 
Management > Resource Configuration > Configuration Menu > General 
section > Other Settings).

2 For the non_serial_match_profile parameter key, click Customize and enter 
the following value:

"com.exlibris.repository.mms.match.OCLCMatchProfile" ="035 
(Other System Identifier) Match Method" 

3 For the serial_match_profile parameter key, click Customize and enter the 
following value:

"com.exlibris.repository.mms.match.OCLCSerialMatchProfile" 
="035 (Other System Identifier) Match Method"  

4 Click Save.

NOTE:
Sometimes, the Share with Network functionality may fail if the 
configuration settings differ between the Network Zone and the 
Institution Zone. The same match profile should be chosen for both the 
Network Zone and the Institution Zone.

Icons and Indicators Displayed in the Network and 
Institution Tabs

 Library   icon – This icon is displayed in the Network tab if the record is 
linked to the local institution (with or without inventory).

 Held by: <institution name> – This indicator is displayed in the Network 
tab if inventory exists for the resource at one of the network member 
institutions, including your own. 

Figure 1: 

Figure 3: Held By Indicator in the Network Tab

You can click the institution’s name and view detailed information of 
resources held by the institution, as illustrated below.
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Figure 4: Display of Resources Held by the Institution

 Community Zone   icon – This icon is displayed in the Institution tab for 
bibliographic records of electronic resources that are activated from the 
Community Zone by individual Network Zone members.

Alma is able to show in the Network tab Community Zone bibliographic 
records that are used by members. The Network tab includes all 
bibliographic records of electronic resources that are activated from the 
Community Zone by the individual Network Zone members. Network 
Zone member holdings for these Community Zone bibliographic records 
can be accessed as described in the Held by: <institution name> explanation 
above. As a result, the Network Zone includes a comprehensive view of all 
bibliographic records in the collaborative network for both physical and 
electronic material. 
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Figure 5: Institution Tab Displays the “49th parallel...” Record Logged into the Network 
Zone

 Shared icon   – This icon is displayed in the Institution tab if a local 

resource is linked to a shared bibliographic record, as illustrated below. 

Figure 6: Institution Tab – Shared Icon

The Shared icon also displays in the Community tab to identify shared 
electronic resources. When member institutions do an All titles search in the 
Community Zone, Alma identifies Community Zone resources that are 
available to them via the Network Zone. When searching the Community 
tab, Alma places the Shared (network) icon next to the Community Zone 
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resource indicating that it is available to the member institution from its 
Network Zone (see below).

Figure 2: 

Figure 7: Community Zone Resource Identified as Available in the Network Zone from the 
Community Tab

Also, when searching from the Community tab, if a resource is available to 
the member in both the Institution Zone and the Network Zone, the 
Institution icon appears next to the resource on the Community tab (the 
local resource always takes precedence).

When doing an Electronic Portfolio or Electronic Collection search from 
the Community tab, if you don’t have the resource at the Institution Zone 
and you do have it at the Network Zone, you see the Shared (network) icon 
next to the electronic portfolio or the electronic collection resource with the 
following exceptions:

 If the resource is identified as Available For your institution, the 
Institution icon appears next to the resource in the Community tab.

 If the resource is identified in an Available For Group that contains 
your institution, the Institution icon appears next to the resource in the 
Community tab.

VIDEO:
For information about improved visualization of shared electronic 
resources with the shared icon, see the Improved Visualization of Shared 
Electronic Resources video (1:13 mins).

For information on additional icons that can be found in search results (that are 
not collaborative network‐specific), see Using the Repository Search Results 
List in the Alma Resource Management Guide.

https://www.youtube.com/watch?v=YnSQEgZQcCA&feature=youtu.be
https://www.youtube.com/watch?v=YnSQEgZQcCA&feature=youtu.be
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Coverage Statement Provided with Available For Group 
Information in Staff Search Results 

In multicampus and collaborative network environments, Alma includes 
portfolio coverage information as it relates to the Available For group(s) in 
Repository Search results. Refer to the illustration below for an example.

Figure 3: 

Figure 8: Available For Coverage Statement

Available For Service Level Displays in Electronic Collection 
Search Results 

When Available For groups settings are specified at the service level, they 
display in the search results of the electronic collection to which they are 
attached. Since Available For settings at the service level override the Available 
For settings at the electronic collection level, it is beneficial to see the service 
level settings in the electronic collection search results in order to know who has 
access to the electronic resource because it is possible for the electronic collection 
and electronic service Available For group settings to be different. Refer to the 
illustrations below.

The electronic collection search results for this example are: 

Figure 4: 

Figure 9: Electronic Collection Search Results with Available For Service Level Indicated

The electronic collection (EBSCOhost Texas Reference Center) Available For Group 
Setting is North Group in the following example:
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Figure 5: 

Figure 10: Available For Group Setting for Electronic Collection

The electronic service Available For Group Setting for EBSCOhost Texas Reference 
Center is East Group in the following example: 

Figure 6: 

Figure 11: Available For Group Setting for Electronic Service

Since the electronic service Available For Group Setting overrides the electronic 
collection Group Setting, the electronic collection search results in Figure 9 
display East Group, the electronic service level setting (that takes priority). 
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Configuring an Error Message to Be Displayed When 
Manually Adding 9XX Fields to Network Zone Records

By default, when you manually add 9XX local fields to the Network Zone using 
the MD Editor, only a warning message is displayed and not an error message. 
You can, however, configure Alma to display an error message (in red) and 
prevent the modified record from being saved.

To configure Alma to display an error message and prevent the record 
from being saved:

1 On the Metadata Configuration List page (Resource 
Management > Resource Configuration > Configuration 
Menu > Cataloging > Metadata Configuration), click the MARC21 
Bibliographic link in the Profile column. 

2 Click the Validation Exception Profile List tab.

3 Select Actions > Edit for the MARC XML Bib Metadata Editing On Save 
profile.

4 On the Validation Severity Profile Exceptions page, select Local field cannot 
be added on network record in the Add Validation Severity Exception 
section, and click the Add Validation Severity Exception button.

Figure 12: Add Validation Severity Exception

When adding a 9XX local field to a network zone record, you will receive an 
error message such as the following and Alma will prevent you from saving the 
record.
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Figure 13: Displayed Error Message in MD Editor

Working with Available For Group Information in 
the Community Zone Updates Task List

For multicampus or collaborative network environments, Alma has added an 
Available For filter and a new Available For column to the Community Zone 
Updates Task List page (Resource Management > Manage Inventory > 
Community Zone Updates Task List). 
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Figure 7: 

Figure 14: Available For Filter and Available For Column

With the Available For filter, you can choose to display the Community Zone 
Updates Task List by group. The Available For filter works in combination with 
any selections that you have made with the Action filter.

The display of the Available For filter and the Available For column is effective 
with the January release starting on 4 January 2015. If you choose to view the 
Community Zone Updates Task List with a date range prior to 4 January 2015, 
the Available For filter and the Available For column will not display.

The groups that display in the Available For column reflect the most current 
Available For information effective with the most recent harvesting. This is the 
harvesting that runs on the Community Zone data every week after midnight 
on Sunday.

Local Extensions to Bibliographic Records in the 
Network Zone

PERMISSIONS:
 Catalog Operator

 Catalog Manager
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Alma provides the ability to add and edit local extensions to a bibliographic 
record that is maintained in the Network Zone. The purpose of the local 
extensions is to provide a place for you to enter local information and, at the 
same time, maintain the integrity to the original and ongoing updated versions 
of the Network Zone record for other Network Zone members. 

Specifically, you can enter local information in the 9XX fields. These fields are 
always identified as local fields. Also, the 09X, 59X, and 69X fields may contain 
local information. However, these fields may also be a part of the Network Zone 
record. Local extensions may be added using the MD Editor (refer to Adding 
Local Extensions Using the MD Editor on page 19) and by running a MARC 21 
Bib Normalization job (refer to Adding Local Extensions by Running a MARC 
21 Bib Normalization Job on page 22).

Adding Local Extensions Using the MD Editor
When you are working in the MD Editor, local fields for Network Zone records 
are identified by the library icon.

Figure 15: Local Library Icon for a Network Zone Record

To add a local field to a Network Zone record using the MD Editor:

1 Open a Network Zone record in the MD Editor.

2 Select Edit > Add Localized Field to enter 9XX, 09X, 59X, or 69X field 
numbers.
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Figure 16: Add Localized Field Menu Option

Figure 17: 59X Field Added as a Local Field

See below for an illustration of a record that is maintained in the Network 
Zone that has different local field extensions for different Network Zone 
members.
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Figure 18: Local Field Extension Example 1
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Figure 19: Local Field Extension Example 2

Adding Local Extensions by Running a MARC 21 Bib 
Normalization Job

You can use the MARC 21 Bib Normalization job to normalize Network Zone‐
linked records that contain local fields such as the 9XX fields. This job only 
makes changes to the local fields and saves them to the Institution Zone. Since 
these are local changes, they are not distributed to the Network Zone or other 
members.

This feature extends the functionality of the normalization drool (part of a 
normalization process) for records that are linked to the Network Zone. The 
normalization processes can be accessed/added on the Normalization tab of the 
Profile Details page (Resource Management > Resource Configuration > 
Configuration Menu > Cataloging section > Metadata Configuration > click 
MARC21 Bibliographic link). 
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Figure 8: 

Figure 20: Normalization Tab for MARC21 Bibliographic Processes

To run a batch job to make global changes on local extensions on 
Network Zone-linked records:

1 Create a normalization rule to be selected for the Drools File Key parameter 
in the next steps. See To create a new normalization rule file: on page 309 
in the section Working with Normalization Rules on page 308 in the Alma 
Resource Management Guide.

2 Create a normalization process for the purpose of adding local extensions to 
Network Zone‐linked records. SeeTo add a process: on page 824 in the 
section Working with Normalization Processes on page 820 in the Alma 
Resource Management Guide 

3 Create/save the set of records to be updated.

4 Run a normalization job. The job’s name is based on a normalization process 
that you already created and appears in the list of manual jobs that you can 
run on defined sets. For more information, see Running Manual Jobs on 
Defined Sets in the Alma Administration Guide.
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Linking Sets of Institution Zone Records to 
Network Zone Records

PERMISSIONS:
 Digital Inventory Operator

 Catalog Manager or Administrator

 Electronic Inventory Operator

 Repository Manager

 Requests Operator

Alma provides the ability to link Institution Zone bibliographic records to 
bibliographic records that are managed in the Network Zone. You do this by 
running a job called Linking set records to Network Zone on the set of records.

To link sets of Institution Zone records to Network Zone records:

Run the Link a set of records to the Network Zone job. For more information, 
see Running Manual Jobs on Defined Sets in the Alma Administration Guide.

Overlaying Community Zone Records in the 
Network Zone

PERMISSIONS:
 Digital Inventory Operator

 Catalog Manager or Administrator

 Electronic Inventory Operator

 Repository Manager or Administrator

 Requests Operator

Alma allows Institution Zone members to import full bibliographic records and 
overlay the brief Community Zone bibliographic records in the Network Zone 
and also retain which member institutions have activated the resources (which 
is indicated by the Held By field).



 Consortia in Alma

25December 2015

VIDEO:
For more information on overlaying community zone records in the 
network zone, see the Overlay Community Zone Records in the Network Zone 
video (9:51 mins).

To overlay Community Zone records in the Network Zone:

1 On the Resource Management Configuration page (Resource Management 
> Resource Configuration > Configuration Menu), click Import Profiles 
under Record Import.

The Run Import page opens.

2 Scroll to the import profile that you want to edit in the list or locate it using 
the Find box at the top of the list, and then select Actions > Edit. 

The Import Profile Details page opens.

3 Click the Match Profile tab to open it.

Figure 9: 

Figure 21: Import Profile Details Page - Match Profile Tab

4 Select the Unlink bibliographic records from community zone check box.

http://www.youtube.com/watch?v=VW1ZGW8q6nw&hd=1
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NOTE:
This field appears only if the ignore_cz_records parameter is set to false in 
the CustomerParameters mapping table (Resource Management > 
Resource Configuration > Configuration Menu > Other Settings).

5 Click Save.

For more information about creating import profiles in a collaborative 
network, refer to Working With Import Profiles for the Collaborative 
Network on page 28.

Configuring Rota Templates and Rota 
Assignment Rules in the Network Zone

PERMISSIONS:
To configure a rota template, you must have the following role:

 Resource Sharing Partners Manager (assigned in the Network Zone)

To configure a rota assignment rule, you must have the following role:

 Fulfillment Administrator (assigned in the Network Zone)

Rota templates and rota assignment rules can now be centrally configured in the 
Network Zone and automatically distributed to the network member 
institutions. Rota templates and rota assignment rules display on their 
respective pages with a Scope value of Network.

The Distribute Central Resource Sharing Configuration job distributes the rota 
templates and rota assignment rules to all network member institutions. The job 
is monitored in the Network Zone.

To save a rota template located in the Network Zone to the Institution 
Zone:

1 On the Rota Templates page (Fulfillment > Resource Sharing > Rota 
Templates), locate a template with a Scope value of Network.

Figure 10: 

Figure 22: Rota Templates Page – Network Scope
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2 Select Actions > Duplicate. The General Information page opens, where you 
can modify the parameters of the rota template.

3 Click Save. The template saves as an institution template (Scope = 
Institution).

NOTE:
The Network Rules List section displays only after the Distribute Central 
Resource Sharing Configuration job runs and copies the rota templates to 
the Network Zoneʹs member institutions. For details on the Distribute 
Central Resource Sharing Configuration job output, see Distribute 
Central Resource Sharing Configuration in the Alma Administration 
Guide.

To save a rota assignment rule located in the Network Zone to the 
Institution Zone:

1 On the Rota Assignment Rules List page (Fulfillment > Fulfillment 
Configuration > Configuration Menu > Resource Sharing > Rota 
Assignment Rules), locate a rule in the Network Rules List section.

Figure 11: 

Figure 23: Rota Assignment Rules List Page – Network Rules List Section

NOTE:
The Network Rules List section displays only after the Distribute Central 
Resource Sharing Configuration job runs and copies the rota templates to 
the Network Zoneʹs member institutions. For details on the Distribute 
Central Resource Sharing Configuration job output, see Distribute 
Central Resource Sharing Configuration in the Alma Administration 
Guide.

2 Select Actions > Duplicate. The Rota Assignment Rules page opens, where 
you can modify the parameters of the rota assignment rule.

3 Click Save. The rule saves as an institution rule (Scope = Institution). The 
Update Date value updates accordingly.
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Using the Network Harvesting Report
Institution bibliographic records that are linked to bibliographic records 
managed in the Network Zone are automatically updated with any 
modifications that took place in the Network Zone. Alma provides a detailed 
Network Harvesting report that displays a list of all updates, deletions (that is, 
links to the resource that were deleted), and errors for these records.

The Network Harvesting report (Resource Management > Manage 
Inventory > Network Harvesting Report List) is available to all network 
member institutions and is refreshed every five minutes. It contains the 
following information for each resource:

 Resource ID

 Type of operation in the network (update, deletion, error)

 ID of the member institution that performed the operation

 Date of the operation

Figure 24: Network Harvesting Report

Working With Import Profiles for the 
Collaborative Network

Any network member institution can configure import profiles of any type 
(authority, initial authority, new order, update inventory, repository) and 
specify that record files be handled through the Network Zone rather than the 
local institution during the Run Import process. For general information on 
configuring import profiles, refer to Importing Records Using Profiles in the 
Alma Resource Management Guide.
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To define an import file for the Network Zone:

1 On the Run Import page (Resource Management > Resource 
Configuration > Configuration Menu > Import Profiles or 
Acquisitions > Acquisitions Configuration > Configuration 
Menu > Import Profiles), click Add New Profile. The Import Profile Details 
wizard opens.

2 Choose the profile type and click Next. Step 2 of the Import Profile Details 
wizard opens with an additional option, Use Network Zone, displayed.

Figure 25: Import Profile Details – Step 2

3 Select the Use Network Zone check box, fill in the other parameters as 
described in Creating an Import Profile Part 2: Entering Profile Details in 
the Alma Resource Management Guide, and click Next.

For more information regarding Use Network Zone, refer to Update 
Network Zone Bibliographic Records as Part of the Shelf‐Ready 
Workflow on page 31.

4 Fill in the parameters in step 3 of the wizard as described in Creating an 
Import Profile Part 2: Entering Profile Details in the Alma Resource 
Management Guide and click Next.

5 In step 4 of the wizard, different options are displayed in the Match Actions 
and No Match sections.

 Under Match Actions, instead of Import, there is a Use NZ record 
option. Select this option to link to the matching Network Zone record 
instead of importing a new record in the case of a match. 

 Also under Match Actions, to have obsolete or discontinued records 
deleted from the network zone, select the check box Allow 
bibliographic record deletion. (See Figure 26.) The system checks to 
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make sure no institutions are linked to the Network Zone record before 
deleting the record.

 Under No Match, select whether you want to add the record to the 
Network Zone, import a local copy of the record (Import to IZ), or not 
import the record at all if no matching record is found.

Figure 26: Import Profile Details – Step 4

6 Click Next and proceed with the following steps in the wizard as described 
in Creating an Import Profile Part 2: Entering Profile Details in the Alma 
Resource Management Guide. 

For information on importing record files using the import profile you 
created, see Running a New Import Job in the Alma Resource Management 
Guide.

NOTE:
Effective with the November 2015 release, the match mechanism for the 
Network Zone has been enhanced for import processing. Previously, 
when a member import found a match in the Network Zone and the 
bibliographic record in the Network Zone was linked to the Community 
Zone, the Network Zone record attached to the Community Zone was 
skipped and was not presented to the member in the Institution Zone. 
With the November 2015 enhancement, import processing presents the 
Community Zone linked record in the Institution Zone (identified in the 
member’s Repository Search results with the Community Zone icon on 
the Institution tab), enabling the member to create inventory/PO lines. If 
you prefer the older method for handling matches, contact Ex Libris 
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Support to disable the parameter for the November 2015 enhancement. 
The November 2015 enhancement also assumes that the customer 
parameter (ignore_cz_records) in the mapping table for ignore 
Community Zone records is set to false.

Update Network Zone Bibliographic Records as Part of the 
Shelf-Ready Workflow

It is possible to update Network Zone bibliographic records as part of the shelf‐
ready workflow. This is accomplished with the import profile parameter Use 
Network Zone.

With this parameter and the By PO Line match method selected, the system is 
able to merge/overlay Network Zone bibliographic records, in addition to 
updating inventory, when the import job is run by a member institution. This is 
especially useful when the imported bibliographic record is a full bibliographic 
record that you want to automatically merge with or overlay on a brief 
bibliographic record in the Network Zone.

With the Use Network Zone parameter selected for import profiles that are 
updating inventory using the By PO Line match method, the system focuses 
only on Network Zone‐linked bibliographic records and ignores/skips the local 
bibliographic records while continuing to use the local PO line data to identify 
matching records. The import job report provides a count for Number of 
records skipped. If this number is greater than zero, there are local records 
(records not linked to the Network Zone) that were not processed as part of the 
import job and will need to be handled separately.

To create an import profile with the Use Network Zone parameter:

1 Open the Run Import page (Resource Management > Resource 
Configuration > Configuration Menu > Record Import section > Import 
Profiles).

2 Click Add New Profile.

3 Select the Update Inventory profile type and click Next.

The Import Profile Details page opens with the Use Network Zone 
parameter in the Profile Details section.
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Figure 12: 

Figure 27: Use Network Zone Import Profile Parameter

4 Select the Use Network Zone parameter and complete the remainder of the 
Profile Details section as you normally would.

5 Click Next and complete the Normalization and Validation Exception 
Profile sections as you normally would.

6 Click Next.

The Match Profile section displays the By PO Line match method.
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Figure 13: 

Figure 28: By PO Line Match Method

7 Complete the remainder of the import profile as you normally would.

Linking PDA Load Records to the Network Zone

PERMISSIONS:
 Purchasing Operator

 Purchasing Manager

Libraries can use an institution‐level PDA program in the context of the 
Collaborative Network. Candidate bibliographic records can be imported from 
the Institution Zone and uploaded or linked to the Network Zone bibliographic 
records.

To set a PDA load profile to use records linked to the Network Zone:

1 On the Patron Driven Acquisitions (PDA) List page (Acquisitions > 
Advanced Tools > Patron Driven Acquisitions (PDA)), select one of the 
following:

 the Add PDA button to create a new profile with records linked to the 
Network Zone

 Actions > Duplicate in the row of the existing profile to which you want 
to add this feature
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Figure 14: 

Figure 29: Add or Duplicate a PDA

The PDA Details page opens.

Figure 15: 

Figure 30: Use Network Zone on PDA Details Page

2 Enter any required information in the fields.

3 To link loaded records to the Network Zone, select the Use Network Zone 
check box.

4 Click the Save button to save your edits (Cancel to discard the change).

The PDA load profile now links bibliographic records to the Network Zone.
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Central License Negotiation
Alma supports managing vendor license negotiations by the collaborative 
network central office on behalf of collaborative network members. 

License Coverage
The negotiation is managed in the Network Zone, where the central office 
creates a license of the type Negotiation, which includes:

 Negotiation details

 Member for which the license is being negotiated

 Member contact email

 Price 

 Currency

 License start/end date

 Note

 License content

 Electronic collections

 Titles that are part of the negotiation

The license content is managed centrally in the Network Zone electronic 
inventory with appropriate group settings representing the member for 
which the license content has been created.

The license content should be associated with the central license.

 License terms of use: managed in the central license

Members for whom a license is negotiated can purchase the centrally 
managed content according to the license’s negotiated details.

Setting Up a Negotiated License

PERMISSIONS:
The following role can manage a collaborative network license:

 License Manager for the Network Zone
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To set up this license:

1 Log on to the Network Zone for your collaborative network.

2 From the Licenses and Amendments page (Acquisitions > Acquisitions 
Infrastructure > Licenses), click the Add License button.

The License Details page opens to the Summary.

Figure 16: 

Figure 31: Summary Page of Wizard

3 Enter information on the License Details Summary page. See Adding a 
License in the Alma Acquisitions Guide for detailed information about the 
fields. 

4 Because this is a Network Zone license, the field License type appears with 
two options, Negotiation or License (see figure below). Select Negotiation.

Figure 17: 

Figure 32: License Type Fields for Network Zone 
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5 When you finish entering information in the fields, click Save. The license is 
saved and you are returned to the list of licenses.

6 Find the license you just created in the list. 

7 Select Actions > Edit to open all the tabs of your license. 

Standard license tabs appear on the page as well as the Negotiation Details 
tab.

Figure 18:  

Figure 33: Negotiation Details Tab for Network Zone License

To set the terms of the license, see Adding a License in the Alma Acquisitions 
Guide.

NOTE:
If content has been entered on a tab for this page, the gray box turns bright 
blue as an indicator, as in the Inventory tab in Figure 33.

8 Add members to the license (see below).

To add members to the license:

1 From the Licenses and Amendments page, Negotiation Details tab (see 
above), click the Add Member button.

The Member Summary page opens.

Figure 19:  

Figure 34: Member Summary Page
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2 To select a member institution, click the search or arrow icon in the Member 
field and choose an option from the list.

3 Enter any additional details for the license.

4 Click Save.

The Network Zone Setup page opens (two members added in the figure 
below).

Figure 20:  

Figure 35: Network Zone Setup

To complete the Network Zone setup, ensure that the vendor collection is 
associated with the appropriate group setting for the institutions as well as with 
the license.

For information on working with group settings in a collaborative network, see 
Configuring Inventory Available For Management Groups for Collaborative 
Environments.

Order Electronic Resources Negotiated and 
Managed in the Network Zone by Member

Collaborative network members can purchase electronic resources that are 
negotiated and managed for them by the central office in the Network Zone. 
Before they can do this, the central office of the Network Zone must create a 
Negotiation license and make it available to the institution. The Negotiation 
license must have an entry for the current member, and the resource must also 
be linked to the Negotiation license.

The member should be listed in the negotiation details as a member for this 
license.
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VIDEO:
For more information about ordering electronic resources negotiated and 
managed by the center office in the Network Zone, see the Order E‐
Resources Negotiated and Managed in the NZ by a Member video (9:35 mins).

See Central License Negotiation on page 35 for information on setting up a 
Negotiated license.

Network Zone

PERMISSIONS:
The following role can associate an electronic resource with a Negotiated 
license:

 License Manager (for the Network Zone)

To associate an electronic resource with a Negotiated license: 

1 Perform a repository search for the electronic collection or portfolio you 
want the license to incorporate.

Figure 21: 

Figure 36: Edit Option for Results of Search

2 Click Edit for the entry you want to associate with the license. The Editor 
page for the electronic collection or portfolio opens (see below).

http://www.youtube.com/watch?v=nXcl1rrb_JE&hd=1
http://www.youtube.com/watch?v=nXcl1rrb_JE&hd=1
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Figure 22: 

Figure 37: License Field on General Information Tab

3 In the Acquisitions and License Information section, click the search/find 
icon (magnifying glass/arrow) for the License field. 

The list of all licenses opens.

Figure 23: 

Figure 38: Select Negotiation License

4 Find the license you want to use for this resource and select its button. The 
license must be of the type Negotiation. 

5 Click Select. 

The license you selected populates the License field.
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6 Enter any additional information you want for the Electronic Collection 
Editor. See Managing Electronic Collections in the Alma Resource 
Management Guide for more information.

Institution Zone

PERMISSIONS:
The following Institution Zone roles can license electronic resources 
through a Negotiated license:

 Inventory Operator or Manager (Institution Zone/Consortium Member)

To purchase a centrally negotiated electronic resource:

1 Log on to Alma as an institution that is part of a collaborative network.

2 Perform a repository search of the Network Zone. (The resource should be 
an electronic collection or portfolio, and your institution should be included 
in the Network Zone license along with the resource. This will have been set 
by the central office of the collaborative network.)

Figure 24: 

Figure 39: Search of Network Resources

3 Find the result entry that contains the resource you want to order and click 
Order.



December 201542

Consortia in Alma

Figure 25: 

Figure 40: Select Network Resource

NOTE:
Your institution’s name and code should appear in the Collection 
Available For filter list in the left column and in the Available For notation 
in the entry, as shown below.
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Figure 26: 

Figure 41: Institutions That Can Order This Resource

After you select Order, the PO Line Owner and Type form opens.

Figure 27: 

Figure 42: New PO Line Order Form 

4 Select entries for the required fields and click the Create PO Line button. 

The system creates a purchase order for the institution. This PO is linked to 
the centrally managed inventory in the Network Zone, inventory that shows 
on the PO line. The inventory tab of the Institution Zone PO line lists the 
Network Zone inventory to which the PO line is linked.

The inventory on the Network Zone should be Active. It is not editable by 
the Institution Zone members.
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VIDEO:
For additional information about ordering e‐resources through the 
Network Zone, see the Order E‐Resources Negotiated and Managed in the NZ 
by a Member video. 

Managing Multiple Matches Across Institution 
and Network Zones

When importing records from the Network Zone to the Institution Zone, 
multiple matches may occur. To help determine which record to overlay or 
merge, Alma presents the following information for the matches:

 A held‐by indication at the record level that gives information about the 
Network members that are using the record. 

 The MMS ID of the record (for searching for the record in the Network 
Zone, if necessary)

To resolve issues of multiple matches:

1 From the Resolve Import Issues page (Alma > Resource Management > 
Import > Resolve Import Issues), locate the match files in question by 
running a search or using a filter, if necessary.

Figure 28: 

Figure 43: Resolve Import Issues – All Matching IDs

For example, a search using the field Profile name might return two rather than 
twenty results (as seen in the illustrations above and below).
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Figure 29: 

Figure 44: Resolve Import Issues – Narrowed by Profile Name 

2 Click Edit from Actions drop‐down list (far right on the table) for the first 
issue you want to resolve. The Handle Matching page opens.

Figure 30:  

Figure 45: Handle Matching Import Records

3 Click the View button corresponding to the record whose matches you want 
to view. The Import Record Matches page opens. 
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Figure 31:  

Figure 46: MMS ID and Held by Information in Matched Record List

The original and MARC records can be viewed in the left pane. In the right 
pane, a list of matched records show with information key to processing 
them:

 MMS ID, which can be used to search for matching records in the 
Network Zone

 Held by, which can help you determine which records to overlay, merge, 
and/or delete. 

From here, you can determine a record’s source and holdings, which allows 
you to make an informed decision regarding how you want to handle the 
match. Options appear in the menu below the match records (as shown in 
the following illustration).



 Consortia in Alma

47December 2015

Figure 32:  

Figure 47: Actions for Matching Records

4 Select an action from the drop‐down menu and click Execute to perform the 
action or Merge Preview to see a preview of the record before performing 
the merge.

The system processes the record as you directed and returns you to the list 
of matching records.

Google Scholar/Primo Central Publishing
Collaborative networks can configure an environment in which each member 
institution can share electronic resources at the campus/library level. For 
detailed information, see Adding a Profile for a Multicampus Configuration in 
the Integrations with External Systems Guide.

OCLC Publishing
For information regarding OCLC publishing in a collaborative network 
environment, refer to OCLC Publishing in a Collaborative Network 
Environment in the Alma Integrations with External Systems Guide.
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Configuring Inventory Available For 
Management Groups for Collaborative 
Environments

PERMISSIONS:
The following roles can configure institution inventory network groups:

 Repository Administrator

 General System Administrator

The following role can define availability for electronic collections and/or 
portfolios:

 Electronic Inventory Operator

In a collaborative environment, electronic resources are managed centrally in 
the Network Zone. In some cases in the Network Zone, there are requirements 
to limit access to electronic resources to a certain group of members within the 
collaborative network. That is, the electronic resources in the Network Zone are 
not available to all the patrons across the entire collaborative network. 

In order to address this requirement and manage which members in the 
Network Zone have access to the electronic resources, Alma provides the 
Available For functionality (configurable inventory management group 
settings). The purpose of inventory management groups is to provide you the 
capability of limiting access to identified electronic resources. 

If resources are available for all members of the network, there is no need to set 
up management groups or Available For definitions since, by default, active 
resources are available for all patrons.

VIDEO:
For more information about searching for electronic resources by 
Available For groups, see the Search by Available For Groups video (4:11 
mins).

For information about searching and working with repository search results for 
electronic resources managed using Available For, refer to Working with 
Jointly Managed E‐Resources (Search/Search Results) on page 82.

A group represents a set of one or more institutions for which you want to 
manage electronic resources similarly. Group setting characteristics or 
considerations include the following:

 One or more institutions may be defined in a single group

 One institution can be a part of multiple groups

http://www.youtube.com/watch?v=LsbZIIUAkLk&hd=1


 Consortia in Alma

49December 2015

 Settings should be defined in a manner that eases the management and 
activation of electronic resources

Groups are assigned to electronic resources using Add Settings for Group (refer 
to Adding Group Settings to Electronic Resources on page 394 in the Alma 
Resource Management Guide).

With the Inventory Network Groups configuration options, you can define 
groups that you can use to manage access to electronic resources. You can define 
one or more institutions within a specific group for sharing electronic resources. 
Refer to the steps below for configuring inventory management groups.

NOTE:
In order for Inventory Network Groups to display as a configuration 
option in the Resource Management configuration menu, someone with 
the General System Administrator role needs to set the parameter value to 
true for the multi_campus_inventory_management parameter in the 
mapping table located in Administration > General Configuration > 
Configuration Menu > General Configuration section > Other Settings. 
Before implementing this feature, consult with Ex Libris.

To add an inventory management group:

1 On the Inventory Available For Management Groups page (Resource 
Management > Resource Configuration > Configuration Menu > 
General > Inventory Network Groups), click Add Group. The Add Group 
dialog box opens.

2 Assign a name to the group, optionally enter a description, and click Add 
and Close.

Figure 48: Add Group

The Inventory Available For Management Groups page displays the group 
that you added.

3 Select Actions > Edit for the group you added. The Inventory Management 
Group Details page is displayed.
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Figure 49: Inventory Management Group Details Page

4 Select one of the previously defined institutions and click Add Institution. 
The institutions are added to the list of group members.

Figure 50: Group List

5 Continue adding institution members until the group is complete. When 
you are finished, click Back to return to the Inventory Available For 
Management Group Details page. 

IMPORTANT:
It is strongly recommended that you do not delete Available For groups 
after they are set and associated with inventory. If you delete an Available 
For group that is connected to inventory, the relevant Available For 
setting in the inventory is also deleted. Available For group association 
with inventory is done via an internal ID; and once it changes (such as 
when groups are deleted), the association will not be kept. Refer to 
Adding Group Settings to Electronic Resources on page 394 in the Alma 
Resource Management Guide for more information regarding associating 
Available For groups with inventory.
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Inherited Group Settings
For Network Zone (or multicampus) environments that have group settings 
defined, the electronic collection, service, and portfolio editors display Available 
For inherited group settings from the higher level. That is, portfolios inherit 
from services and services inherit from collections. The inherited group settings 
are listed after the Available For heading.

Figure 33: 

Figure 51: Inherited Available For Group Settings

In the example shown above, the group settings are inherited from the 
electronic collection in which they were defined (see below). 

Figure 34: 

Figure 52: Inherited Group Settings Defined

See below for an example of one of the portfolios that has inherited group 
settings from this same definition.
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Figure 35: 

Figure 53: Inherited Group Settings for a Portfolio

VIDEO:
For additional information regarding Inherited Available For Groups, 
refer to the E‐Resources: Inherited ”Available For” Groups video. 

Defining Display Logic Rules at the Campus 
Level

PERMISSIONS:
The following roles are required to update display logic rules:

 Fulfillment Administrator

 General System Administrator

For multicampus environments (multi_campus_inventory_management = true 
in the CustomerParameters mapping table), Alma allows you to define display 
logic rules at the campus level for the following electronic services: full text, 
selected full text, database services, and general electronic services. Alma 
applies the display logic rules in multicampus environments as follows:

 The campus for which the services are calculated is based on the IP address 
from which the patron triggers the Alma Services page or the campus 
affiliation of the logged‐in patron. If Alma determines that a patron is 
logged on at a different campus, the calculated electronic services are based 
on the display logic rules defined for both campuses.

 Display logic rules that are enabled at the campus level override all 
electronic display logic rules enabled at the institution level. 

http://www.youtube.com/watch?v=xjiQ98IJbso&hd=1
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 For non‐electronic services, Alma also applies the display logic rules that are 
enabled at the institution level.

 If no campus‐level display logic rules are enabled, Alma applies all display 
logic rules that are enabled at the institution level.

NOTE:
It is a known issue that display logic rules are not supported at the 
campus level when the campus parameter is included in an OpenURL. 
This will be resolved in a later release.

To define display logic rules at the campus level:

1 On the Fulfillment Configuration page (Fulfillment > Fulfillment 
Configuration > Configuration Menu), click Display Logic Rules under 
Discovery Interface Display Logic.

Figure 36: 

Figure 54: Discovery Interface Display Logic Page

2 Click Add Rule.
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Figure 37: 

Figure 55: Add Rule Dialog Box

3 Select one of the following electronic services from the hide service drop‐
down list: DB Service, Full Text, General Electronic Service, or Selected 
Full Text.

Figure 38: 

Figure 56: Electronic Service Selected

4 Select a campus from the when in campus drop‐down list

5 Fill out the remaining fields and click Add and Close.

The Add Rule dialog box closes, and the new rule is added under the 
Campus Rules section on the Discovery Interface Display Logic page. 
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Figure 39: 

Figure 57: Rule Added to Campus Rules Section

To view rules for another campus, select the campus from the Campus 
drop‐down filter.

Shared Vendor Information 
Global vendor information can be shared between the Network Zone of and 
member institutions. This alleviates the need for the member institutions to add 
vendor information independently. Each member of the collaborative network 
can define its own local parameters for its vendors.

The Distribute Network Acquisition Changes to Members job distributes the 
new vendor information that has been added to the Network Zone to member 
institutions. The job copies all vendors that have been added to the Network 
Zone since the date set by the acq_distribute_changes_last_run parameter 
(Acquisitions > Acquisitions Configuration > Configuration Menu > General 
> Other Settings). If the parameter is empty, all vendors in the Network Zone 
are copied to the member institutions. 

Only global attributes are distributed from the Network Zone. These attributes 
cannot be configured on the local level. Local attributes (such as vendor account, 
EDI information, access provider, and vendor interface) are not distributed from 
the Network Zone. These attributes can be configured on the local level. Because 
the vendor account, access provider, and vendor interface are not distributed to 
member institutions, the vendor is inactive in the member institution until these 
attributes are added and the vendor is activated.
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If a vendor that exists in a member institution is added to the Network Zone, the 
first time the job runs, the job changes the vendor to a shared vendor and adds 
the global attributes (such as contact information), but does not change the local 
attributes. Subsequently, runs of the job leave the vendor as local (not shared).

VIDEO:
For more information about working with shared vendors in a 
collaborative network, see the Shared Vendors in the Network video (6:44 
mins).

PERMISSIONS:
The following roles are required to update display logic rules:

 Acquisitions Administrator

 General System Administrator

To configure this feature:

1 On the Acquisitions Configuration page (Acquisitions > Acquisitions 
Configuration > Configuration Menu > General > Other Settings), click 
Customize for the acq_distribution_job and change the parameter value 
to True. 

Figure 58: Acquisition Configuration Parameters

2 Click Save.

https://www.youtube.com/watch?v=_HIUpVrZx0E&hd=1
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NOTE:
For more information, see Configuring Other Settings in the Alma Acquisitions 
Guide.

To run the Distribute Network Acquisition Changes to Members job:

1 In the list of scheduled jobs, activate Distribute network acquisition 
changes to members. For more information, see Distribute Central 
Resource Sharing Configuration in the Alma Administration Guide.

2 View the list of vendors (Acquisitions > Acquisitions Infrastructure > 
Vendors). The new Shared column indicates which vendors are shared by 
member institutions. Newly shared vendors are inactive.

Figure 59: Shared Vendor Column

3 Click Edit for a shared vendor. Global attributes are non‐editable
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Figure 60: Global Attributes

Centralized Management of Configuration 
Tables

PERMISSIONS:
The roles that allow you to perform configurations for the various 
functional areas can access this feature.

Institutions that administer the Network Zone in a collaborative network can 
perform configuration changes and distribute them automatically to member 
institutions. This allows for easier coordination between member institutions 
and reduces duplication of effort. 

Both configuration tables that are configured at the table level and configuration 
tables that are configured at the row level can receive customizations from the 
Network Zone.

The following conditions apply:
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 If a member institution performs a customization in a configuration table, 
changes from the Network Zone do not overwrite the changes to the 
configurations for that row or table.

 If a member institution does not want to receive customization changes 
from the Network Zone, it can customize the row or table (without 
necessarily changing any data), which will block it from receiving Network 
Zone customizations. 

 If a member institution later decides to receive customizations from the 
Network Zone, it can click Restore, which changes the configurations for 
that row or table to the Network Zone configurations and allows that row or 
table to receive Network Zone configurations in the future. 

 If a member institution that has customized a row or table that is managed 
by the Network Zone wants to return the settings of that row or table to the 
original settings before any customizations (OTB), it must do so manually 
(that is, the Restore button does not have this functionality for rows and 
tables managed by the Network Zone).

 If a Network Zone administrator clicks Restore and Save and Distribute for 
a row or table, the settings in the member institution are restored to the 
original settings before any customizations (OTB) of that row or table.

 If a Network Zone administrator clicks Stop Network Management, 
changes performed in the Network Zone are no longer distributed to 
member institutions. This action leaves member institution data unchanged, 
that is, a restore is not preformed.

 Despite all of the above, when distributing a table, the Network Zone can 
select to force the distribution to the member institution, overriding all 
changes made in the member institution.

The Distribute Network Zone configuration table changes to member 
institutions job distributes any changes made to the Network Zone to the 
member institutions.

NOTE:
Currently this functionality is only available for select configuration 
tables.

The workflow is different depending on whether the configuration table is one 
that is configured at the table level or the row level.

To centrally manage configuration tables configured at the row level:

1 From the Network Zone, select a configuration table that is configured at the 
row level.

2 Select Customize > Actions > Manage in Network for the row that you 
want to manage in the Network Zone.
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Figure 61: Row Configuration Table

A green check mark appears in the Managed in Network column of the 
row, indicating that the row is managed by the Network Zone.

Figure 62: Managed in Network 

3 Perform any customizations that you want to distribute to member 
institutions.

4 Click Save to save the configuration changes without distributing them to 
member institutions or click Save and Distribute to save the configuration 
changes and distribute them. If you click Save and Distribute, click 
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Confirm in the confirmation dialog box to run the job that distributes the 
changes to member institutions.

The configuration changes are distributed to the member institutions when 
the job runs. Network is displayed in the Updated By column both in the 
Network Zone and the member institution.

5 To stop centralized management of configuration tables, click Stop Network 
Management for the row, and then click Save and Distribute and Confirm 
in the confirmation dialog box.

Figure 63: Stop Network Management

Configuration changes performed in the Network Zone are no longer 
distributed to member institutions.
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To centrally manage configuration tables configured at the table level:

1 From the Network Zone, select a configuration table that is configured at the 
table level:.

Figure 64: Table Configuration 

2 Click Manage Table in Network.

The value for the Managed in Network field changes to Yes and the Stop 
Network Management and Save and Distribute buttons are displayed:
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Figure 65: Managed in Network 

3 Perform any customizations that you want to distribute to the member 
institutions.

4 Click Save to save the configuration changes without distributing them to 
member institutions or click Save and Distribute to save the configuration 
changes and distribute them. If you click Save and Distribute, a dialog box 
appears.

Figure 66: Distribute Table to Network Members Confirmation Dialog Box

a In Distribution Mode, optionally select Override Member Institution 
Customization to force the table to be distributed to all member 
institutions, even the ones that made local customizations in the table.

b Click Confirm to run the job that distributes the changes to member 
institutions.

The configuration changes are distributed to the member institutions. The 
value for the Managed in Network field changes to Yes and the value in the 
Updated By column changes to Network in the member institutions.
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5 To stop centralized management of configuration tables, click Stop Network 
Management, and then click Save and Distribute and Confirm in the 
confirmation dialog box:

Figure 67: Stop Network Management

Configuration changes performed in the Network Zone are no longer 
distributed to member institutions.

VIDEO:
For a video on Centralized Management of Configuration Tables, see the 
Centralized Management of Configuration Tables video.

Centralized Management of Notification Letters

PERMISSIONS:
To access this feature, you must have one of the following roles:

 General System Administrator

 Letter Administrator

Alma produces a variety of letters as a means of notification. Institutions that 
administer the Network Zone in a collaborative network can customize 
notification letter templates and distribute them automatically to member 
institutions in a collaborative network. This allows for easier coordination 
between member institutions and reduces duplication of effort. 

https://www.youtube.com/watch?v=9gVGosR9sfw&feature=youtu.be
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The following conditions apply:

 If a member institution customizes a letter, changes from the Network Zone 
do not overwrite the changes to the letter.

 If a member institution does not want to receive customization changes 
from the Network Zone, it can customize the letter (without necessarily 
changing any data), which blocks it from receiving Network Zone 
customizations.

 If a member institution later decides to receive customizations from the 
Network Zone, it can perform a restore, which changes the configurations 
for the letter to the Network Zone customizations and allows that letter to 
receive Network Zone configurations in the future. 

 If a member institution customizes a letter that is managed by the Network 
Zone and wants to return the settings of that letter to the original settings 
before any customizations (OTB), it must do so manually (the Restore 
button does not have this functionality for letters managed by the Network 
Zone).

 If a Network Zone administrator clicks Restore and Distribute for a letter, 
the settings in the member institution are restored to the original settings 
before any customizations (OTB) of that letter if the member institution did 
not perform any customizations.

 If a Network Zone administrator clicks Stop Network Management and 
Distribute, changes performed in the Network Zone are no longer 
distributed to member institutions. This action leaves member institution 
data unchanged—that is, a restore is not performed.

 The Distribute Network Letter Template Changes to Members job 
distributes any changes made to letters in the Network Zone to the member 
institutions.
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To access this feature:

1 From the Network Zone, select the letter template that you want to 
distribute to member institutions (Administration > General Configuration 
> Configuration Menu > General Configuration > Customize Letters):

Figure 68: Manage in Network

2 Select Customize > Actions > Manage in Network for the letter that you 
want to manage in the Network Zone.

A green check mark appears in the Managed in Network column for the 
letter that indicates that that letter is managed by the Network Zone.

Figure 69: Managed in Network

3 Perform any customizations that you want to distribute to member 
institutions.
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4 Click Distribute to distribute the configuration changes. Click Confirm in 
the confirmation dialog‐box to run the job that distributes the changes to 
member institutions.

The configuration changes are distributed to the member institutions when 
the job runs. Network appears in the Updated By column both in the 
Network Zone and the member institution.

5 To stop centralized management of notification letter templates, click Stop 
Network Management for the letter, and then click Distribute and Confirm 
in the confirmation dialog‐box.

Figure 70: Stop Network Management

Letter customizations changes performed in the Network Zone are no 
longer distributed to member institutions.

Relinking a Portfolio to a Different Bibliographic 
Record in the Network Zone

For information regarding relinking a portfolio to a different bibliographic 
record in the Network Zone, refer to the procedure To relink a portfolio to a 
different bibliographic record: on page 472 in the Alma Resource Management 
Guide.
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Sharing Import Profile Templates in the Network 
Zone

PERMISSIONS:
The following role can work with import profiles:

 Catalog Administrator

With this template capability, you can share vendor‐specific import profile 
definitions in order to simplify the integration with vendors for ongoing 
workflows such as repository import and embedded order data import. 

Collaborative network import profiles managed centrally in the Network Zone 
can be used as templates that can be copied/customized at the member level.

To create a Network Zone import profile template:

1 Log in to the Network Zone (not member) system.

2 Click Import Profiles from the Record Import section (Resource 
Management > Resource Configuration > Configuration Menu). The 
Import Profiles page opens.

Notice the following:

 Tabs for Institution and Community

 Status column heading (with Active, Inactive, or Template statuses)

Figure 40: 

Figure 71: Import Profiles Page

3 Click Add New Profile.

4 Select Repository and click Next.
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5 Enter Profile name, Originating system, and select Template for the Status 
parameter. 

Figure 41: 

Figure 72: Template Status

6 Click Next and complete the remainder of the profile as usual.

To copy a Network Zone import profile template:

1 Log in to a member system.

2 Click Import Profiles from the Record Import section (Resource 
Management > Resource Configuration > Configuration Menu). The 
Import Profiles page appears.

Figure 42: 

Figure 73: Import Profiles Page with Network Tab
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3 Select the Network tab.

4 Select Actions > Copy in the row of the template with which you want to 
work. The Profile Details tab opens on the Import Profile Details page.

5 Edit the import profile details to match your requirements. Refer to the 
Creating an Import Profile Part 2: Entering Profile Details on page 649 
section in the Alma Resource Management Guide for information regarding the 
import profile parameters and options.

6 When you have completed your import profile changes, click Save.

7 Select the Institution tab to view the profile that you copied. By default, the 
copied profile has copied from information appended to the profile name. 

Figure 43: 

Figure 74: Copied Template

Monitoring Collaborative Network Jobs Across 
Institutions

The Network Zone can monitor the jobs run by member institutions of a 
collaborative network. 

PERMISSIONS:
The following roles have access to the Monitor Jobs page and can monitor 
the jobs that are relevant to their roles:

 General System Administrator



 Consortia in Alma

71December 2015

 Repository Manager

 Catalog Manager

 Catalog Administrator

 Requests Operator

 Purchasing Operator

 Purchasing Manager

 Acquisitions Administrator

To access this feature:

From the Network Zone, open the Monitoring Jobs page (Administration > 
Manage Jobs > Monitor Jobs). The Institution Name filter in the Running and 
History tabs allows you to filter the results to view jobs run by a member 
institution, the Network Zone, or all institutions. 

Figure 75: Institution Name Filter

NOTES:
 The Network Zone cannot abort a job run by member institutions.

 For the Network Zone, report and event data is read‐only; there are no 
Actions buttons or links inside the report.

Switching Between Institutions
Members of a collaborative network can easily switch between member 
institutions for which they have a user account. 
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For collaborative networks that use a single sign‐on (SSO) authentication 
mechanism based on the SAML or CAS protocols, member institutions can 
further switch between member institutions without having to log in separately 
to each institution.

To access this feature:

An Institutions link appears at the top of all pages in Alma for the Network 
Zone and member institutions in a collaborative network. 

Figure 76: Institutions Link

1 Click the Institutions link to display a drop‐down list of all the institutions 
in the collaborative network. 

2 Select the member institution to which you want to log in.

The Alma home page of the member institution you selected opens.

NOTE:
You must have an account in the member institution to log in to it.

Additionally, you can configure a widget for the Alma home page that allows 
you to switch between member institutions. 

Figure 77: Institutions Link Widget

For more information about configuring widgets, see the Widgets section of the 
Alma Administration Guide.
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Centralized Cataloging in the Network Zone 
Alma provides additional support for collaborative networks that, as a central 
cataloging policy, only permit cataloging in the Network Zone, not the 
Institution Zone. With this new capability, Alma provides a new parameter 
setting for central record management that locks institutions from creating local 
Institution Zone records. This locking implementation affects the following 
areas where local Institution Zone records can be created:

 MD Editor new record creation/copy cataloging (import from an external 
resource)

 Metadata Import

 Quick Cataloging

 MARC Record Simple View copying

To set the central_record_management parameter from the Network 
Zone:

1 In the General section of Resource Management Configuration (Resource 
Management > Resource Configuration > Configuration Menu) click 
Other Settings to open the Mapping Table page.

2 Click Customize for the parameter key central_record_management.

3 Set the parameter value to true.

Figure 44: 

Figure 78: central_record_management Parameter Set to True

The Customize button changes to Actions with the following options:

 Manage in Network

 Restore
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Figure 45: 

Figure 79: Network Zone Actions Button

4 Select Manage in Network to identify this setting for distribution to the 
member institutions.

Figure 46: 

Figure 80: Network Zone Managed in Network Setting

5 Click Save and Distribute to have this setting copied to the member 
institutions (along with all the other settings identified as Managed in 
Network).

To view the MD Editor changes when central_record_management is set 
to true:

1 Open the MD Editor (Resource Management > Cataloging > Open 
Metadata Editor).

2 Select File > Options. 
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Figure 47: 

Figure 81: MD Editor File Menu > Options

The placement of bibliographic records and rules can be handled 
independently. Since central_record_management is set to true, the 
placement of bibliographic records defaults to the Network Zone and 
cannot be changed, while the placement of rules can be done either locally 
or in the Network Zone.

3 View the File menu.
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Figure 48: 

Figure 82: MD Editor File Menu > Share with Network

The Share with Network option remains a part of the menu for times when 
member institutions may have local (Institution Zone) records that perhaps 
came across as part of the migration process and those records need to be 
shared with the Network Zone. This is not an available option for new 
records, and usually this is an inactive option when 
central_record_management is set to true.

To view the handling of local portfolios and their related bibliographic 
records when central_record_management is set to true:

1 Open the New Portfolio page (Resource Management > Create Inventory > 
Add Local Portfolio).

2 Create a new (local) portfolio and click Save. The new (local) portfolio 
appears in the Institution tab on the Repository Search page with the local 
icon.
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Figure 49: 

Figure 83: New Local Portfolio in the Member Institution with central_record_management 
Set to True

3 Complete an All titles search for the new local portfolio in the Institution 
tab. The bibliographic record appears in the Institution tab on the 
Repository Search page with the Network icon showing that the 
bibliographic record for the newly created local portfolio was stored in the 
Network Zone.

Figure 50: 

Figure 84: All Titles Search for a New Local Portfolio in the Member Institution with 
central_record_management Set to True

4 Complete an All titles search for the new local portfolio in the Network tab. 
The bibliographic record appears in the Network tab on the Repository 
Search page with the local icon indicating that the institution has inventory 
associated with the network bibliographic record.
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Figure 51: 

Figure 85: All Titles Search in the Network Tab for a New Local Portfolio in the Member 
Institution with central_record_management Set to True

To view the handling of local portfolios and their related bibliographic 
records when central_record_management is set to false:

1 Open the New Portfolio page (Resource Management > Create Inventory > 
Add Local Portfolio). The parameter Placement of new record enables the 
user to select either Network or Institution for the placement of the 
bibliographic record. Note that another value may appear in place of the 
label Network if the configuration parameter network_label was changed.

Figure 52: 

Figure 86: Add New Local Portfolio with central_record_management Set to False

2 Select Network or Institution for your new title and complete the 
remainder of the parameters as you normally would.

To view the quick cataloging (Add Physical Item) changes when 
central_record_management is set to true:

1 Open the Quick Cataloging page (Resource Management > Create 
Inventory > Add Physical Item) by selecting New for Choose Holding 
Type and click Choose. Or open the Quick Cataloging page from patron 
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fulfillment (Fulfillment > Checkout/Checkin > Manage Patron Services, 
enter the patron’s ID, click Go, and click Create Item).

Figure 53: 

Figure 87: Add Physical Item in the Member Institution with the 
central_record_management Set to True

2 Create a new (local) item and click Save. 

3 Complete a Physical items repository search for the new (local) item. It 
appears in the Institution tab on the Repository Search page.

Figure 54: 

Figure 88: New Local Item in the Member Institution with central_record_management Set 
to True

4 Complete a Physical titles search for the new local item in the Institution 
tab. The bibliographic record appears in the Institution tab on the 
Repository Search page with the Network icon showing that the 
bibliographic record for the newly created local item was stored in the 
Network Zone.
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Figure 55: 

Figure 89: All Titles Search for a New Local Portfolio in the Member Institution with 
central_record_management Set to True

5 Complete an All titles search for the new local item in the Network tab. The 
bibliographic record appears in the Network tab on the Repository Search 
page with the local icon indicating, that the institution has inventory 
associated with the network bibliographic record.

Figure 56: 

Figure 90: All Titles Search in the Network Tab for a New Local Item in the Member 
Institution with central_record_management Set to True

To view the MARC Record Simple View copying changes when 
central_record_management is set to true:

1 Complete an All titles search from the Community tab in the repository 
search.

2 Click the title link for a record in your search results to open the title in the 
MARC Record Simple View page. The MARC Record Simple View page 
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provides only the Copy to Network option to enable creating/copying the 
record in the Network Zone (not the Institution Zone). 

Figure 57: 

Figure 91: MARC Record Simple View in a Member Institution with 
central_record_management Set to True

To view the import profile changes when central_record_management is 
set to true:

1 In the Record Import section of Resource Management Configuration 
(Resource Management > Resource Configuration > Configuration Menu) 
click Import Profiles to open the Import Profiles page.

2 Click Add New Profile.

3 Select the Repository profile type and click Next. The Import Profile Details 
page appears.
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Figure 58: 

Figure 92: Use Network Zone Parameter Locked with the Yes Setting

The Use Network Zone parameter is locked with the Yes setting versus the 
optional check box setting (see below). 

Figure 59: 

Figure 93: Use Network Zone Parameter with the Optional Check Box
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Creating Records in the Network Zone with the 
Portfolio Loader

Central cataloging in collaborative networks has the ability to create and match 
bibliographic records in the Network Zone with the Alma Portfolio Loader.

When the central_record_management parameter is set to true and portfolios 
are imported locally using the Alma Portfolio Loader, the system checks for 
matching bibliographic records in the Network Zone; and when no 
bibliographic record match is found in the Network Zone, a new bibliographic 
record is added to the Network Zone to which the loaded portfolio is linked. 

There is a Bibliographic section in the Portfolio Loader wizard with the Select 
catalog options of Institution and Network. When the 
central_record_management parameter is set to true, the Select catalog 
option is set to Network and cannot be changed, thereby ensuring that 
bibliographic records are stored in the Network Zone (not the Institution Zone). 

Figure 60: 

Figure 94: Activation Wizard: File Upload Page

When the central_record_management parameter is set to false, the Select 
catalog option can be set to either Institution or Network providing the option 
to store bibliographic records in either location. 
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To view the new capability for the Alma Portfolio Loader (when the 
central_record_management parameter is set to true):

1 Complete a repository search to locate the electronic collection to which you 
want to load portfolios.

2 From the repository search results, click the Edit Service link for the 
electronic collection to which you want to load portfolios.

3 Select the Portfolios tab and click Load Portfolios. The Activation Wizard: 
File Upload page appears displaying the Bibliographic section that contains 
the Select catalog options of Institution and Network with Network 
selected as the default and not changeable. 

When portfolios are imported locally using the Alma Portfolio Loader (and 
the central_record_management parameter is set to true), the system 
checks for matching bibliographic records in the Network Zone and 
processes the results in the following manner:

 When no bibliographic record match is found in the Network Zone, a 
new bibliographic record is added to the Network Zone to which the 
loaded portfolio is linked.

 When a single bibliographic record match is found in the Network Zone, 
a link to that matching bibliographic record is created.

 When multiple bibliographic matches are found in the Network Zone, 
nothing is done (manual handling may be required).

4 Complete the remainder of the wizard for loading portfolios as you 
normally would.

Linking Local Inventory to Bibliographic Records 
in the Network Zone or the Community Zone

Alma provides options for linking local portfolios and electronic collections to 
Network Zone or Community Zone bibliographic records. 

To link local portfolios to the Network Zone or the Community Zone when 
creating local portfolios:

1 Click Add Local Portfolio (Resource Management > Create Inventory). The 
New Portfolio page appears. 

2 Select Create new title or Use existing title for the Creation type.
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 When you select Create new title, the Placement of new record options 
appear enabling you to select Network or Institution for the placement/
linking of the bibliographic record for your portfolio.

If your institution has configured central_record_management to be 
true (refer to Centralized Cataloging in the Network Zone on page 73 
for more information), the Placement of new record options do not 
appear on the New Portfolio page since choosing 
central_record_management would indicate that you want your 
bibliographic records managed only in the Network Zone and not the 
Institution Zone.

Figure 61: 

Figure 95: New Portfolio Page Create New Title

 When you select Use existing title (see below), the Placement of new 
record options dynamically are removed from the page. Instead, when 
you browse to choose a title (bibliographic record to link to), the search 
options provide access to the bibliographic records in the Network tab 
and the Community tab. Previously, the system only provided browsing 
of the Institution Zone records. 
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Figure 62: 

Figure 96: New Portfolio Page Use Existing Title

Figure 63: 

Figure 97: Browse Network Tab and Community Tab for the Bibliographic Record to Which 
You Want to Link

To link electronic collections to the Network Zone or the Community Zone:

1 Complete a search for the electronic collection that you want to link to a 
Network Zone or Community Zone bibliographic record.

2 From the search results, click the Edit link for the electronic collection that 
you want to link to a Network Zone or Community Zone bibliographic 
record. The Electronic Collection Editor page appears.

3 Select the Additional Information tab. 
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Figure 64: 

Figure 98: Additional Information Tab

4 Browse the Additional descriptive information parameter to locate the 
Network Zone or Community Zone bibliographic record to which you want 
to link your electronic collection.

Figure 65: 

Figure 99: Browse Additional Descriptive Information
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Figure 66: 

Figure 100: Browse Network Tab or Community Tab

5 From the search results, select the bibliographic record to which you want to 
link and click Select.

6 Complete the remainder of any changes that you have in the Electronic 
Collection Editor as you normally would.

To link electronic collections to the Network Zone or the Community Zone 
from the Activation Wizard:

1 Click Manage Electronic Resource Activation (Resource Management > 
Manage Inventory) to locate the electronic collection that you want to 
activate. The Electronic Resource Activation Task List page appears.

2 From the task list, select Actions > Activate for the electronic collection you 
want to activate. The Activation Wizard: Electronic Collection and Services 
Setup page appears.

3 Browse the Additional descriptive information parameter to locate the 
Network Zone or Community Zone bibliographic record to which you want 
to link your electronic collection.
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Figure 67: 

Figure 101: Browse Additional Descriptive Information in the Activation Wizard

Figure 68: 

Figure 102: Browse Network Tab or Community Tab

4 From the search results, select the bibliographic record to which you want to 
link and click Select.

5 Complete the remainder of the Activation Wizard as you normally would.

Relinking Holdings to the Network Zone or the 
Community Zone

The holdings relinking capability provides the capability to relink to 
bibliographic records in the Network Zone or the Community Zone.
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To relink holdings records to bibliographic records in the Network Zone or 
the Community Zone:

1 Complete a Physical titles search in the Institution tab from the repository 
search (Resource Management > Search and Sets > Repository Search).

2 For the title that you want to relink, click the Holdings link. 

Figure 69: 

Figure 103: Holdings Link

The MARC Record Simple View page appears.

Figure 70: 

Figure 104: Relink from the MARC Record Simple View

3 Click Relink. The MD Editor opens with a search panel enabling you to 
locate a bibliographic record in the Network Zone or Community Zone in 
addition to the Institution Zone to which you can relink.
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Figure 71: 

Figure 105: MD Editor Relink Search Panel

4 Select Network or Community, enter search criteria for a bibliographic 
record to which you want to relink, and click Search. The search results 
appear in the MD Editor from which you can identify the bibliographic 
record to which you want to relink.

Figure 72: 

Figure 106: Relink Search Results

5 Click Relink for the bibliographic record to which you want to link in the 
Network Zone or Community Zone (depending on which zone you selected 
for your search). The record to which you did a Relink opens in the MD 
Editor.



December 201592

Consortia in Alma

Figure 73: 

Figure 107: Relinked Record Opens in the MD Editor

6 Click Save.

Cataloging Privileges in the Network Zone
Refer to the section Cataloging Privileges on page 230 in the Alma Resource 
Management Guide for information describing the implementation of cataloging 
permission levels and any special considerations for the Network Zone.
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